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About the 

 

Information Alley

 

The

 

 Information Alley 

 



 

 is a 
publication of Apple 
Computer, Inc., Support 
Information Services. The 
goal of the 

 

Information Alley

 

 
is to help you get full use of 
your Apple computers, 
peripherals, and software.

 

Where to Find the 

 

Information 
Alley

 

The 

 

Information Alley

 

 is 
available to anyone through a 
variety of online services and 
Internet list server capability. 
For a complete list of where 
to find the 

 

Information Alley

 

, 
call the Apple Fax line at 1-
800-505-0171 and request 
document #20720. You can 
also get an index to back 
issues by requesting 
document #20719. 
Optionally, you can search 
the Technical Information 
Library; use “information 
alley” as the search string. 
Select article title 

 

Information 
Alley: Online Services it is 
Posted To

 

 or article title 

 

Information Alley: Index of 
Past Issues

 

.

 

Submissions and Letters

 

We welcome articles that 
help Apple computer users 
become more knowledgeable 
about the functionality of their 
systems, explain or illustrate 
complex features or 
functions, or that describe 
technical tips or techniques. 
Send submissions to:

 

Information Alley

 

Apple Computer
1200 East Anderson Lane
MS 212-STI
Austin, TX 78752

Fax: (512) 908-8018
email: alley@apple.com

We also welcome letters to 
the editor and suggestions
for future articles. Please 
send all letters to the 
preceding address.

 

Copyright Notice

 

This newsmagazine is 
copyrighted, with all rights 
reserved. Individual articles in 
this newsmagazine may be 
reprinted, in their entirety, 
without prior written 
permission from Apple as long 
as full credit is given to Apple 
Computer and the 

 

Information 
Alley 

 

is listed as the source of 
the information.

You must have prior written 
permission from Apple 
Computer to excerpt or 
paraphrase portions of articles 
from this newsmagazine. For 
permission, contact: 

Janet Christian, Editor

 

Information Alley

 

 
Apple Computer
1200 East Anderson Lane
MS: 212-STI
Austin, Texas 78752

Voice: (512) 908-8975
Fax: (512) 908-8018
email: alley@apple.com

 

Trademarks

 

The Apple logo is a trademark of 
Apple Computer, Inc., registered in 
the U.S. and other countries. 
Apple, the Apple logo, APDA, 
AppleLink, AppleShare, AppleTalk, 
A/UX, EtherTalk, HyperCard, 
HyperTalk, ImageWriter, 
LaserWriter, LocalTalk, Macintosh, 
and ProDOS are trademarks of 
Apple Computer, Inc., registered in 
the U.S. and other countries.
Apple Desktop Bus, Balloon Help, 

Disk First Aid, Finder, SuperDrive, 
Information Alley, “Get off the 
Highway and Into the Alley”, and 
TrueType are trademarks of Apple 
Computer, Inc.

Classic is a registered trademark 
licensed to Apple Computer, Inc.

AppleCare is a service mark of 
Apple Computer, Inc., registered in 
the U.S. and other countries.

All other products mentioned in this 
newsmagazine are trademarks of 
their respective companies. 
Mention of third-party products is 
for informational purposes only and 
constitutes neither an endorsement 
nor a recommendation. Apple 
assumes no responsibility with 
regard to the performance of these 
products.

Apple Computer, Inc., products 
(hardware and software) described 
in this newsmagazine are subject to 
update and change. This news- 
magazine makes no assurance that 
functions and technical information 
described here is not superceded 
by subsequent releases of the 
product described.

The 

 

Information Alley

 

 is produced 
using FrameMaker 4.0 on a Power 
Macintosh running System 7.5.
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By Janet Christian

 

Send Us Your Tips &Tidbits

 

Want to contribute something to the 

 

Information Alley

 

 but don’t have time to 
write an article? How about something 
for 

 

Tips & Tidbits

 

! 

We are always on the lookout for “nifty 
stuff” to put in 

 

Tips & Tidbits

 

. These 
little green boxes help keep the 

 

Information Alley

 

 from being a dry, 
stuffy technical newsmagazine. While 
the main articles may be the “meat” of 
the magazine, 

 

Tips & Tidbits

 

 are 
certainly the dessert! Besides, everyone 
likes to find out the “secret” or “special” 
things their applications and systems 
can do.

Send your idea to 

 

alley@apple.com

 

 or 
fax it to (512) 908-8018. Be sure to 
include your name so that we may give 
you credit. If you send in a 

 

Tips & 
Tidbits

 

 item from another source (such 
as one of the many “Easter Egg” files 
that exist) please let us know which file 
you got it from, so that we may give 
appropriate source credit.

 

Article Variety 

 

We strive in each issue of the 

 

Information Alley

 

 to include a wide 
variety of topics – from the products 
covered to the technical depth of 
articles. We select articles for 
publication based on your direct 
suggestions to us, telephone and fax 
reports of “hot topics and issues,” and 
issues that are new or recently changed 
(such as a patch release or a bug report). 

If you have a favorite topic you would 
like to see addressed in the 

 

Information 
Alley

 

, please let us know. 

 

Article Accuracy

 

Each article we publish in the 

 

Information Alley

 

 is reviewed by a team 
of technical experts (I call them the 
Alley Oopers). Once in a while a mistake 
slips through; we appreciate hearing 
about it from you. One of the side 
benefits of publishing the 

 

Information 
Alley

 

 is that all of the articles we publish 
either go into or initially come out of 
the Technical Information Library (TIL). 

When a new article is published in the 

 

Information Alley

 

, adding it to the TIL 
helps us provide an ever-growing 
number of top quality articles for our 
phone reps and for you. (We now export 
a large portion of the TIL to several 
online services – see Volume I Issue 10 
for an article about the TIL and for 
locations where the TIL is exported).

When an article is reprinted from the 
TIL, we ensure that it is up-to-date and 
of current interest. In some cases, we 
find that a “hot” topic is only partially 
covered by a TIL article that is several 
years old and is no longer current. 
Updating the article helps our phone 
reps better answer your questions when 
you do call. In addition, only currently-
dated articles are exported, so updating 
older but still interesting articles makes 
them available to you, too. All in all, the 

 

Information Alley

 

 seems to be a 
successful endeavor – and one we plan 
to continue for the foreseeable future. 

 



 

Thoughts from the Alley Cat (Editor)
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From the Technical Information Library

An alias is a pointer to an icon. The icon 
can be anything: a document, 
application, INIT, folder, disk, file server 
– even another alias. A file can have an 
infinite number of aliases. Aliases let 
you refer to documents, folders, and 
applications with minimal impact on 
disk space, but with maximum 
convenience of location.

An alias is a small file that “remembers” 
the location of the original file, rather 
than containing the same data as the 
original. An alias file is typically 1K or 
2K.

Once an alias is created, either the alias 
or the original may be moved to another 
location, although the original must stay 
on the same volume it was on when the 
alias was created. The name of the alias 
is always in italic and has the same icon 
as the original file. You may change the 
name of the alias without affecting the 
original file. When you wish to open the 
original, double-click the alias and the 
system responds as if you had double-
clicked the original.

 

All About Aliases

 

Where You Can Place Aliases

 

When making more than one alias of a 
file/application, you can place them in a 
variety of locations for convenient 
opening, such as the Apple Menu folder 
in your System folder and the folder 
containing the application used to 
create the file.

By placing an alias of files, applications, 
sounds, QuickTime movies, and so on in 
the Startup Items folder in your System 
Folder, these items are automatically 
launched at startup. If you don’t want 
them to load, just hold down the 

 

Shift

 

 
key at startup.

 

Connecting to a File Server

 

To quickly connect to a File Server over 
a network, make an alias of the File 
Server while you are connected to it and 
drag the alias to some convenient place 
on your hard drive. For example, place 
the alias in the Apple Menu Items folder 
in your System folder and you can then 
access the File Server directly from the 
Apple Menu.

 

Removable Media

 

Aliases let you locate files on removable 
media such as floppy disks, CD-ROM 
discs, or removable cartridges. All you 
have to do is make an alias of the file(s) 
on the removable media and place the 
alias on your hard disk. When you 
double-click on the file's alias, you are 
asked for the disk by name that 
contains the original file. This also 
works with compression software used 
in archiving files to floppy disks.

 

Continued on next page...



 

Volume I, Issue 15

 

Information Alley

 

5

 

Pg. 5

 

...Continued from previous page

 

Using Aliases With Remote 
Access

 

To create an alias over an Apple Remote 
Access connection, select the alias icon 
of the remote, mounted hard drive. 
Choose 

 

Get Info

 

 from the File menu, 
then click the 

 

Locked

 

 checkbox. If you 
don’t lock the alias, the alias can be 
converted to call the wrong Apple 
Remote Access server or to try to access 
the service across your local network.

 

Aliases and Upgrading Systems

 

If you upgrade an existing Macintosh 
(such as from a Quadra 700 to a Quadra 
800) and name the new machine the 
same name as the old machine, the 
existing aliases continue to work. They 
continue to work, as long as the 
machine and the volume are named the 
same on the Quadra 800 as they were on 
the Quadra 700.

The explanation of how aliases work is a 
little bit longer. The first step in 
resolving the alias is to identify the 
volume on which the target resides. 
Thus, the alias stores some volume 
mounting information, such as the 
server and zone information. The zone 
name and the server name must be the 
same in order for the alias manager to 
successfully resolve the alias. 
Additionally, if the volume is not a local 
volume (as is the case in this situation), 
the volume name must be the same.

Once the correct volume is found, there 
are a number of ways that the alias 
manager can resolve an alias. One piece 
of information that it uses is the file (or 
directory) ID. Using this, if the file 
moves somewhere else on the volume, 
the alias is able to locate it. 
Additionally, the alias manager uses the 
location and file name to resolve an 
alias.

When an alias is created, the file ID of 
the actual file, is saved within the alias 
record. When you then copy the actual 
file to another location (such as to a new 

drive), the file ID of the “new”, copied 
application is different than the original 
application’s file ID. The alias record 
still contains the original application’s 
file ID. If the alias manager fails to 
resolve the alias by using the file ID, it 
attempts to use the relative path name 
to resolve the alias.  As long as the path 
to the file remains the same, the alias is 
able to be resolved.

Once an alias is used, the alias record is 
updated with any information that had 
changed. For example, if the file ID had 
changed (because it was a copy of the 
original), once the alias is used, the new 
file ID is stored with the alias. After 
that, the file can be moved around, and 
the alias is still able to find it.

The bottom line is, you can copy an 
entire hard drive from one system to 
another (such as the Quadra 700 to the 
Quadra 800). As long as you name the 
machine the same in Sharing Setup, 
name the volume the same, and do not 
move any of the files (or applications) 
that have aliases to them, at least until 
all of the aliases are used, and updated, 
everything should work correctly.

 

If An Alias Fails to Work

 

If you open an alias and nothing 
happens, or you see a message 
reporting that the original file isn’t 
available, it means that the alias is 
damaged, or the original was removed. 
Aliases are not removed when the 
original icon is removed.

First, try to locate the original of the 
alias using the 

 

Find Original

 

 button in 
the Info box of the alias (or you can use 
the Find command). If the original still 
exists and the alias does not work, 
remove the defective alias then select 
the original and make another alias of it.

If you cannot locate the original file, it 
may have been deleted (file or folder) or 
unmounted (volume); or there may be a 
break in the network, and the alias has 
been left pointing to a location that 
contains nothing.

 

 
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From the Technical Information Library

Apple Remote Access
(ARA) Client for 
Macintosh systems
provides an easy, 
productive, and 
secure way to
connect a desktop 
Apple Macintosh 
or PowerBook 
computer to 
information and 
resources at a 
remote location 
over standard 
telephone lines.

 

Differences Between ARA 1.0 
and 2.0

 

• ARA 1.0 had both client and server 
capability, and came with a license to 
copy to three computers. ARA 1.0 
cannot connect to an ARA 2.0 server.

• ARA 2.0 Personal Server comes with a 
license to copy to two computers, and 
can act as a server or a client. There 
is a compatibility mode allowing 
connection to ARA 1.0 servers.

• ARA 2.0 Client can only access ARA 
1.0 or 2.0 servers, it does not provide 
server capability.

 

ARAP 2.0

 

The AppleTalk Remote Access Protocol 
(ARAP) provides efficient AppleTalk 
services on a per client basis over slow 
links. It defines the login and 
authentication sequences. The ARAP 
specification has been enhanced to 
include the ability to change passwords, 
allow password retries, authenticate a 
user using external third party security 
devices, and send out-of-band messages 
such as alerts and greetings. 

 

 Apple Remote Access 1.0 and 2.0 

 

In addition, ARAP Version 2.0 now lets 
administrators of the Multiport Remote 
Access Server set the specific zones 
each user can see. The Apple Remote 
Access MultiPort Server provides a 
flexible, scalable, and secure way to 
offer network access to large numbers 
of remote or mobile users. Used in 
conjunction with one or more Apple 
Remote Access Serial Cards, it lets a 
Macintosh computer or a Workgroup 
Server support from 4 to 16 
simultaneous dial-up connections.

 

Note:

 

The protocol enhancements are 
what allow for the new 
functionality; therefore, ARAP 1.0 
based products are not able to 
take advantage of these 
enhancements.

 

Remote Password Change

 

ARAP 2.0 provides a method for you to 
remotely change your password 
(without having to use AppleShare on 
the same Macintosh as was necessary 
with ARA 1.0). Other new features in the 
MultiPort Server product let the 
administrator set the number of retries 
allowed before user logon is disabled 
and to force users to change their 
passwords via the “New password 
required” field in the user setup window.

 

SNMP Management

 

Integrated network management via 
SNMP is now a part of the MultiPort 
servers.

 

Roving Access Security

 

Dial-back is not satisfactory for you if 
you want both security and mobility. 
Mobile security is now added to the 
feature list by allowing for the use of 
third party “security cards”. With some 
“security cards” you must type in a

 

Continued on next page...
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...Continued from previous page

 

personal code and a requester code into 
a credit card size calculator like device. 
The device then returns the SecureID. 
Other “security cards” are time based 
and constantly display current SecureID 
information. When trying to make a 
connection to a secure server, you see a 
dialog box requesting a SecureID. 
Without the SecureID and the standard 
username and password you are not 
able to get access to the server.

 

X.25 connectivity

 

The new MultiPort Server software 
supports extensions that let you 
connect to ARA through an X.25 
network. This type of access is valuable 
in situations where the cost of X.25 
asynchronous dial-up service is less 
than the cost of end-to-end service 
through the phone companies. These 
X.25 extensions are sold as separate 
products from ARA 2.0 MultiPort server.

 

DialAssist

 

DialAssist is a client software (both ARA 
Personal Server 2.0 and ARA 2.0 Client 
Only) feature that makes long distance, 
credit card, international, and private 
PBX calling extremely easy for you. The 
software is preconfigured with all of the 
most common dialing codes so that a 
you only have to select items from pop-
up menus.

 

MNP10 error correction

If you have a modem that supports 
MNP10 error correction, it can be turned 
on via the Remote Access Setup window.

ARA 1.0 and 2.0 Compatibility
Modem Scripts

You can use AppleTalk Remote Access 
version 1.0 modem scripts with Apple 
Remote Access 2.0 Personal Server, but 
you cannot use certain new features, 
such as Ignore Dial Tone, Manual 
Dialing, and MNP 10. You cannot use 
Apple Remote Access Personal Server 
2.0 modem scripts with AppleTalk 
Remote Access version 1.0.

Calling an AppleTalk Remote Access 
Version 1.0 Server

The AppleTalk Remote Access 1.0 
Compatibility option lets you call a 
version 1.0 server from the ARA 2.0 
client and to receive callbacks from a 
1.0 server (see Chapter 3 of the Apple 
Remote Access Personal Server for 
Macintosh User’s Guide for details on 
setting this option). However, it does 
not let Apple Remote Access Personal 
Server receive calls from an AppleTalk 
Remote Access 1.0 client. The Apple 
Remote Access 2.0 Personal Server can 
only receive calls from version 2.0 
Apple Remote Access Clients.

Supported Scripts

Apple includes some modem scripts 
with all versions of the ARA server. 
These are not the only compatible 
modem scripts. These scripts were 
current when 2.0 was introduced, but 
there could be updates from the modem 
vendors. If you need a new script, 
contact your modem vendor. The 
following paragraph is in the Apple 
Remote Access MultiPort Server Read Me 
file:

“9600-bps or higher-speed modem 
scripts included with the Apple 
Remote Access Client for Macintosh 
software can also be used with the 
Apple Remote Access MultiPort 
Server.”

Basically, 9600-bps or higher-speed 
modem scripts should be compatible 
with the Apple Remote Access MultiPort 
Server product. If an ARA 2.0 script is 
not available for a particular modem, 
the ARA 1.0 script should work.

If you can’t find the CCL script for you 
modem, contact the modem vendor 
directly, check with user groups, or 
develop your own CCLs with tools from 
APDA, Apple’s source for developer 
tools. 
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From the Technical Information Library

This article includes information from 
several articles in the Technical 
Information Library. 

What is the Desktop File?

The Desktop file is an invisible file 
found in the main level of your hard 
drive. It is the file that keeps track of all 
the documents and applications that are 
on your drive. 

The file name is desktop for versions 
of System 6 and earlier. System 7.0 and 
later versions use the invisible files 
named Desktop DB and Desktop DF.

When to Rebuild the Desktop 
File

Occasionally your Desktop file may 
become too large or may be damaged. 

Note: It is generally a good idea to 
rebuild your Desktop file once a 
month or so.

Symptoms of a Damaged Desktop 
File

One symptom of a damaged Desktop file 
is where icons on your desktop appear 

as “generic” rather than “custom” icons. 
Rebuilding the Desktop file may 
eliminate the problem.

The Desktop file manages all icons on a 
particular hard drive or floppy disk. 
When you insert a new or customized 
icon, the Desktop file may not load it or 
may load a previous version of the icon. 
To have the special icon appear on the 
desktop, the Desktop file must be 
rebuilt to update the Desktop file and 
register the icon.

Icons change to generic document 
(blank page with a corner turned down) 
or application (diamond with a hand) 
icons for several reasons, including the 
following:

• Utilities such as compression or 
security software can alter icons.

• Custom icons become damaged or 
deleted.

• The Desktop file has been damaged.

• Applications that create files may not 
assign icons to the files.

• An application that created a file and 
assigned an icon may no longer be 
available.

• A file may have lost the bit that 
indicates a custom icon (this is known 
as the bundle bit).

Symptoms of a Large Desktop File

If the Desktop file becomes too large, 
the computer may have difficulty 
reading it efficiently and speedily. This 
can cause the Finder to access files 
more slowly. Rebuilding the Desktop file 
can clean up old information and speed 
up Finder access. 

Continued on next page...

Desktop File Facts
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Note: You can also make a file-by-file 
backup of the drive, re-initialize 
the drive, and then restore the 
files. This re-groups all the files, 
unfragments them, and increases 
the efficiency of the drive.

How to Rebuild the Desktop 
File

You can rebuild the Desktop manually 
by holding down the Option and 

 

x 
keys while the system is starting up. 

Note: This procedure only works when 
the Finder is loaded. 
Applications like At Ease don’t 
load the Finder, so you must turn 
them off prior to rebuilding.

Rebuilding the Desktop relinks 
documents to their correct applications 
and rewrites the Desktop file itself. 

Note: Rebuilding the Desktop file 
erases any comments you may 
have typed in the Get Info 
windows of files on your disk.

Before rebuilding the Desktop, be sure 
that you have some room available on 
the hard disk. The Desktop rebuilding 
process requires hard disk space, and 
won’t successfully complete without it. 
A good guideline is to always have 5% of 
the hard drive or other volume available 
as free space.

Why the Desktop File 
Sometimes Won’t Rebuild

There are several reasons why you may 
have difficulty rebuilding the Desktop 
file.

A Conflicting INIT or System 
Extension

An INIT or system extension can 
interfere with rebuilding the Desktop 
file. To resolve the problem you can try 
the following:

• For versions of System 6, remove all 
non-Apple extensions from the 

System Folder. Then rebuild the 
desktop file by holding down the 
Option and 

 

x keys while starting the 
computer.

• For versions of system 7, rebuild the 
desktop with extensions off following 
these steps:

If you have used compression or 
security utilities, and the preceding 
solutions don’t work, contact the 
vendors for a solution.

Not Enough Memory to Rebuild

Changing the size of the Finder’s 
partition should not be necessary under 
7.0, as was sometimes necessary under 
System 6. The only way to change the 
size of the Finder’s partition under 
System 7 is either by using ResEdit or 
by booting under System 6.0.x, and 
changing the partition there.

The Finder needs to do a little different 
work under 7.0 than it did under 6.0.x. 
The system is using the Desktop 
Database, rather than the Resource 
Manager, which relieves that bottleneck 
in the system. The Finder can get some 
additional memory from other places, 
like the System Heap, if necessary.

The bottom line is, there really is no 
reason that you should need to alter the 
partition size of the Finder under 
System 7.0.

Continued on next page...

STEP ACTION

1 Hold the Shift key down while 
starting up the computer.

2 As soon as you see “Welcome to 
Macintosh Extensions off”, release 
the Shift key and hold down the 

 

x 
and Option keys.

3 Continue pressing the 

 

x and Option 
keys until a dialog asks you if you 
are sure you want to rebuild the 
Desktop file.

4 Let go of the keys and click on the 
OK button.
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Increasing the Finder’s partition sets 
aside more memory for the Finder and 
increases the size of your System Heap. 
In doing this, you set aside the memory 
for the System Heap but decrease the 
amount of memory for applications.

If you want to try changing the partition 
by booting under System 6.0.x, here are 
the instructions. (Doing this requires 
you to boot up the Macintosh from a 
System 6.0.x diskette, and most 
Macintosh computers introduced after 
the release of System 7 (including 
Quadra and PowerBook computers) are 
not able to use this option.)

Here are the steps for Macintosh 
computers that can start up under 
System 6.0.x:

What to Do If Rebuilding the 
Desktop Doesn’t Restore Your 
Icons

If rebuilding the doesn’t restore your 
icons, run Disk First Aid to see if there 
is a problem you can fix. If you have 
specific files (other than custom icons) 
that became generic icons, there are 

STEP ACTION

1 Restart your Macintosh from a 
startup floppy disk that has System 
6, like the 800K Disk Tools disk from 
the Personal Upgrade Kit (not the 
high-density Disk Tools disk, which 
contains System 7).

2 Locate and click the Finder file in 
your System Folder on your 
Macintosh hard drive (not the Finder 
on the floppy).

3 Choose Get Info from the File menu 
and increase the amount of memory 
allocated to the Finder in the 
Current size box.

4 Close the Get Info window.

5 Restart your Macintosh (from the 
hard drive) under System 7 once 
again.

these possibilities:

• You may not have the applications 
that originally created them. 

• These files may have lost their bundle 
bit. MacTools as well as other disk 
utilities can correct lost bundle bits. 
Disk First Aid won’t detect or repair 
lost bundle bits.

• The application that created them may 
simply not assign an icon to them; 
check with the application’s vendor.

• You may be using custom icons, which 
the Desktop file can’t rebuild. See 
Creating and Using Custom Icon 
Folders on page 11 of this issue. 

Tips and Tidbits

Macintosh ROMs (any of them)

With a debugger, look at the last 
few locations on the ROM of your 
computer. Developers put their 
initials there, as well as the date 
that the ROM was linked. For 
example, the 128k ROM (Mac 
Plus) contains, at $41FFC0-
$41FFFF: 

ALR ELR BA BMB EHB JTC SC 
DLD PWD KWK LAK SEL B
Wed, Nov 6, 1985

These are the initials of Erich 
Ringewald, Bill Atkinson, Bill 
Bruffey, Ernie Beernink, Jerome 
Coonan, Steve Capps, Donn 
Denmann, Pat Dirks, Larry 
Kenyon, and three other 
unknown developers. [From the 
Macintosh/Newton Easter Egg List 
– 1994. Contributed by Scott 
Lindhurst and Ed Tecot.] 
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From the Technical Information Library

System 7 lets you modify the existing 
icons any non-system file, folder, or 
volume. Custom icons are saved directly 
into a file’s resource fork, and an 
attribute bit is set to alert the Finder to 
display a custom icon. Folders and 
volumes don’t have resource forks, 
however, so custom icons are saved 
instead to an invisible file named ICON. 
This file is located at the root level of 
the folder or volume.

Creating a Folder That Uses a 
Custom Icon 

Follow these steps to create a folder 
that uses a custom icon:

STEP ACTION

1 Select the graphic to use for an icon. 
An icon in the Get Info window of 
any document is one possible source. 
You can also use a graphic 
application to create your own.

2 Copy the graphic to the Clipboard by 
choosing Copy from the Edit menu.

3 In the Finder, select the icon you 
want to change.

4 Choose Get Info from the File menu.

5 Ensure that the Locked box in the 
lower-left corner of the Get Info 
window isn’t checked. You cannot 
customize the icon of a locked file.

If the selected graphic is bigger than the 
icon in the Get Info window, it 
automatically shrinks to fit.

Custom Icon Repair

Sometimes custom icons created for 
files, folders, or hard disks become 
damaged or deleted. If the link between 
the folder or volume and the ICON file is 
lost, the Finder may display a generic 
document icon in place of the custom 
icon. When attempting to edit this icon 
through Get Info, you get an error 
message saying that the item can’t be 
found. If you have a damaged custom 
icon on a folder, follow these steps:

If you have a damaged custom icon on a 
volume, you can try a public domain 
utility called Disk Rejuvenator to correct 
it. You can try the steps outlined in the 
next section if you have a disk or file 
utility that lets you make invisible

Continued on next page...

6 Click the icon at the upper-left of the 
Get Info window or press the Tab 
key to select it.

7 Choose Paste from the Edit menu.

8 Click the Close box to close the Get 
Info window.

STEP ACTION

1 Create a new folder.

2 Copy the damaged folder’s contents 
into the new folder.

3 Place the empty folder in the trash.

4 Give the new folder a custom icon by 
following the steps in the preceding 
section.

STEP ACTION

Creating and Using Custom Icon Folders
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You can now find the Information 
Alley on these online services and 
BBSs:

• The Library BBS (Scranton, 
Pennsylvania area) –
(717) 566-1699

28,800 BPS down – 8/1/N. 
Available 24 hours a day. Uses the 
Telefinder BBS software. Home of 
the Hershey Apple Core.

• Mouse (Macintosh Owners and 
Users Society of Edmonton) BBS 
(Edmonton, Alberta, Canada) – 
(403) 460-0541

Four lines at 28,800 BPS. A First 
Class BBS. Available 24 hours a 
day. 

New Places to Find the 
Information Alley

...Continued from previous page

files visible. Another option is to 
reformat the volume.

Warning! Formatting a volume erases 
all data, back up first.

ResEdit and File Utilities for 
Repairing Custom Icons

There is a Finder attribute for folders 
and volumes called “Custom Icon”. You 
can turn this attribute off using ResEdit. 
When the folder reverts to a normal 
folder icon, you can attach a new icon to 
it. ResEdit cannot access this attribute 
for volumes. You can also try to correct 
the problem by following these steps: 

If you correct a damaged icon and it 
becomes damaged again before long, 
you might consider removing the icon 
from your system. 

STEP ACTION

1 From the Finder, create another 
custom icon for a folder by following 
the steps in the How to Create a 
Custom Icon Folder section.

2 Using a file utility such as ResEdit, 
find the ICON file for this newly-
created custom icon (it is at the root 
level of the folder to which it is 
attached) and make that file visible. 
Also make visible the ICON file at the 
root level of the affected volume. 

3 In the Finder, copy the now-visible 
ICON file from the folder to the root 
level of the volume. You may receive 
the message “Are you sure you want 
to replace the older file…” If so, click 
OK. This restores the icon file.

4 Using the file utility, make the ICON 
file invisible again. 

5 Click on the volume once to select it 
and choose Get Info from the File 
menu. You can now edit or delete 
this icon.

Tips and Tidbits

Caps Lock 7.0.1 (on a 
PowerBook 100, 140, 145, or 170)

Turn on balloon help and point to 
the Caps Lock file icon. The 
balloon help reads: “This file 
allows your Macintosh TIM or 
Derringer to display an icon...” 

These were the working names of 
the first PowerBooks; Apple 
forgot to change the extension 
before System 7.0.1 was released! 
Whoops. [From the Macintosh/
Newton Easter Egg List – 1994. 
Contributed by Seth Theriault 
and Fabian Hahn.] 
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From the Technical Information Library

PowerShare Mail Servers provide the 
routing and storage for data exchanged 
between users and applications. Data is 
exchanged between users in the form of 
letters; data is exchanged between 
applications in a format known as 
messages.

Letters and messages are stored in 
containers known as queues on the hard 
disk on which a Mail Server is installed. 
To exchange letters and messages 
through PowerShare Mail Servers, a user 
or application (or other entity such as a 
printer) must have a queue on a 
PowerShare Mail Server.

A record for the Mail Server is stored in 
a PowerShare catalog folder. This record 
provides information about how the 
Mail Server is used to store and forward 
messages and letters.

Note: Your PowerShare System also 
provides access to other mail 
systems. It does this through 
gateways, software, and/or 
hardware products, allowing 
devices on your network to 
communicate with other 
networks running different 
messaging protocols.

Adding a Mail Server

The PowerShare Mail Server has no 
logical limitation to the number of users 
per server. However, the existing 
Macintosh file system does impose 
some limitations; that is 2 GB, or 4 GB 
with System 7.5, maximum hard drive 
volume size. You may run only one 
copy of the PowerShare Mail Server per 
Macintosh accessing only one hard drive 
partition.

Here is a formula we recommend for 
sizing a server:

• (Average number of messages received 
per day + Average number of 
messages sent per day)

• Times the Average size of each 
message in kilobytes

• Times the Number of days users can 
leave mail in their mailboxes without 
deleting

• Divide the answer into the available 
hard disk storage in kilobytes

For example:

• 200 + 300 = 500

• 500 × 1000 bytes (approximately 1K) 
= 500,000

• 500,000 × 10 = 5,000,000

• 100 MB (100,000,000) ÷ 5,000,000 = 
20

This means that the example Mail Server 
can support 20 users (maximum – you 
should allow an extra 10MB for 
“housekeeping”). If you have more users 
than this, you can reduce the number of 
days a mail message is allowed to 
remain on the server, add another 
Macintosh Mail Server, or increase the 
amount of storage available for 
messages.

Continued on next page...

PowerShare Mail Servers
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If you decide you need an additional 
Mail Server to support more users, or 
there is limited free disk space on the 
PowerShare Mail Server, you can create 
another Mail Server on another 
computer and use it to store user 
queues. Because it is not possible to 
have more than one PowerShare Mail 
Server running on a Macintosh at the 
same time, you need to set up another 
server elsewhere on your network. This 
Macintosh must meet the basic 
PowerShare system requirements:

• At least one Macintosh computer 
(using a 68020 or later processor) with 
a hard disk.

• A minimum of 4 MB of memory for 
each installed PowerShare server.

• If both the PowerShare catalog server 
and the PowerShare Mail Server are 
installed on the same computer you 
require at least 8 MB.

• The PowerShare Server system 
requires system software version 7.1.1 
or later. (The PowerShare Installer 
installs System 7.1.1 if it is needed.)

Setting up an additional Mail Server:

STEP ACTION

1 Install the PowerShare software on 
the Macintosh where the new server 
will reside. On restart, the 
PowerShare Easy Setup application 
starts and displays a dialog box 
informing you that the Easy Setup 
application requires some 
information to set up the PowerShare 
System.

2 Click the Later button in the dialog 
box.

3 Open the PowerShare Server Folder 
and double-click on the PowerShare 
Mail Server application to start it. A 
dialog box appears, prompting you 
for an administrator name and 
password and asking you to select a 
PowerShare System to join.

Because the Mail Server is brand new, no 
users are served by it. You can now 
begin assigning the Mail Server to users. 
Take time to plan the assignment, so 
management of the servers is easier. 
You might want to divide users by 
department, floor, geographic location, 
job function, or alphabetically. 

4 Choose a PowerShare System from 
the pop-up menu at the top of the 
window. If the System you want to 
join is not listed in the menu, choose 
Other. The PowerShare Admin 
application begins searching for 
available catalogs on the network, 
displaying a dialog box that indicates 
that a search is in progress.

Depending on the size of the 
network, the search can take from a 
few seconds to several minutes. Click 
Cancel to terminate the search. 
When all PowerShare Systems have 
been located, a dialog box appears 
listing the names of the available 
PowerShare Systems.

5 Click the PowerShare system you 
want to use, then click OK. You are 
returned to the dialog box, where 
you must now supply an 
administrator name and password.

6 In the appropriate fields, type the 
administrator name and password 
that was specified when the 
PowerShare System was set up.

7 When the information is complete, 
click OK. When your identity is 
authenticated, a dialog box appears 
prompting you for a name for new 
Mail Server record. The new server 
must have a unique name.

8 In the Server Name field, type a 
descriptive name.

9 Click New. The new PowerShare Mail 
Server starts up. The new server 
name is registered for use on the 
network and a status window 
appears, displaying information 
about the server's operation. 

STEP ACTION
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By Bob McConachie

There is a problem with a local 
LaserWriter appearing in the incorrect 
zone after dialing into a remote network 
with ARA 2.0. After initiating an ARA 
connection, the local printer appears in 
the Chooser to be in the remote zone 
(zone a), even though it isn’t actually in 
any zone. After selecting a remote 
printer and then terminating the ARA 
connection, the local printer still shows 
up in zone a. The Printer appears in the 
Chooser, but gives the error that it “can’t 
be found” when a job is sent. 

The problem is related to a known 
problem with the Chooser. The problem 
typically appears when attempting to 
connect to LaserWriters on AppleTalk 
networks that have no zone name; that 
is, those that have no routers attached. 
This problem could affect any 
Macintosh that had previously used 
printing services on an Ethernet 
network having zones.

What actually happens is the Chooser 
does not properly update the zone 
name stored in the driver when 
selecting a LaserWriter on a LocalTalk 
network with no zone name. You can 
verify this by looking at the 'PAPA' -8192 
resource in the LaserWriter driver.

This problem is fixed in System 7.5. If 
you encounter this problem, you should 
upgrade to System 7.5.

SolutionProblem

Other than upgrading to System 7.5 you 
could:

• Keep two copies of the LaserWriter 
driver in the Extensions folder, one 
named “LocalLaser” and the other 
named “EtherLaser”. Select the 
LocalTalk/Ethernet printer on the 
network having no zones with the 
“LocalLaser” printer driver and the 
other printer with the “EtherLaser” 
driver.

• Replace the LaserWriter driver every 
time the problem occurs.

• Add a router to the network that 
currently has none. 

Problem with Local Printing After Using ARA

By Anthony Snyder

The Scrapbook in System 7.5 was re-
written to provide greater 
functionality. Two of the new 
features are: support for drag and 
drop clippings, and the ability to 
resize. It was also rewritten as an 
application under System 7.5 rather 
than a desk accessory, which means 
that a certain amount of memory 
can be allocated for the Scrapbook 
application using the Get Info 
command in the Finder.

If you get multiple out of memory 
messages when opening the 
Scrapbook, then increase the 
preferred memory allocation 100-
200K using the Get Info command 
(use the search string change 
program memory in Apple Guide 
for more information). 

System 7.5 – Scrapbook 
Out of Memory Error
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By Mark Hansen

The Auto Power On/Off Control Panel 
lets you set your Macintosh to power ON 
or OFF at a pre-determined time, on a 
daily basis or for one particular day. It 
first appeared with the Macintosh 
Quadra 840AV computer in July, 1993.

The Auto Power On/Off Control Panel 
supports Macintosh computers that use 
the soft power off (in other words, 
systems that do not require you to turn 
the switch off) and the Cuda 
Microcontroller chip.

Additionally, the Control Panel works 
with older soft-power capable Macintosh 
systems that have a version of the 
Motorola 68HC05 microcontroller chip. 
Examples of these systems include the 
Macintosh IIsi, IIvx/IIvi, and the Color 
Classic.

The following is a list of Macintosh 
systems that work with the Auto Power 
On/Off Control Panel that is included 
with System 7.5:

• Macintosh IIsi

• Macintosh IIvx/IIvi

• Macintosh Color Classic

• Macintosh Color Classic II

• Macintosh LC 630

• Macintosh LC 520

• Macintosh LC 550

• Macintosh Quadra 630

• Macintosh Quadra 840AV

• Macintosh Quadra 900/950

• Power Macintosh 7100/66 and AV

• Power Macintosh 8100/80 and AV

• Workgroup Server 95

• Workgroup Server 8150

• Workgroup Server 9150

• Macintosh Performa 575

• Macintosh Performa 577

• Macintosh Performa 578

• Macintosh Performa 550

• Macintosh Performa 600

• Macintosh Performa 630

• Macintosh Performa 635

• Macintosh Performa 636

• Macintosh Performa 637

• Macintosh Performa 638

You can use the Auto Power On/Off 
feature in conjunction with other 
System 7.5 features. For example, you 
could set your system to power on 
during the night and run an Apple Script 
that re-indexes all of your database files 
or backs up your hard drive. 

System 7.5 – Energy Saving Feature
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From the Technical Information Library

All new desktop 
Macintosh computers 

designed since the 
fall of 1993 
support the 
PlainTalk 
microphone.

Macintosh 
computers that 
use the 
PlainTalk 
microphone 
include:

• Macintosh LC and Performa 500 series 
computers

• Quadra 605/LC 475/Performa 475/476

• Quadra 660AV

• Quadra 840AV

• All Power Macintosh computers

• Macintosh 630 family computers

• Power Performa 6100 series 
computers

The following computers are in the 
Macintosh 630 family: Performa 630, 
Performa 635, Performa 636, Performa 
637, Performa 638, LC 630, and Quadra 
630.

The following computers are in the 
Macintosh Performa 6100 series: 
Performa 6110, Performa 6112, 
Performa 6115, Performa 6117, and 
Performa 6118.

All other Macintosh computers that 
support sound input utilize the 
standard Apple Microphone. 

Macintosh Models 
that Support the 

PlainTalk Microphone
By Jim Armstrong

The Apple Presentation System 
(M28955LL/A) has an incompatibility 
problem with the Screen Squeeze V2.1 
Control Panel on a Macintosh LCII. When 
the Screen Squeeze Control Panel loads 
it hangs the system with a bus error.

The problem is with the Screen Squeeze 
Control Panel, which comes with the 
Focus L-TV Portable Pro. Focus 
Enhancements Technical Support is 
aware of the problem suggests replacing 
the Screen Squeeze Control Panel V2.1 
with V2.0.

Note: You replace the newer version of 
the Screen Squeeze Control Panel 
with the older version.

The following information is from Focus 
Enhancements:

2.1 of Screen Squeeze requires the 
presence of the Display Manager. It is 
automatically installed on any 
Macintosh running System 7.5, or if 
the Display Enabler extension is 
installed. If someone experiences a 
startup crash with 2.1, they either 
need to replace it with 2.0 (they 
function the same) or install the 
Display Enabler, whichever is the 
easiest way. 

L•TV Portable
Television

Macintosh

Apple Presentation 
System – Problem 

With Screen Squeeze
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By Jeff Garaventa

The Apple Media Kit is a multimedia 
authoring and digital publishing tool. 
Products developed with the Apple 
Media Kit use QuickTime to play back on 
Macintosh computers and on computers 
using Microsoft Windows.

The Apple Media Kit includes two tools:

• The Apple Media Tool

• The Apple Media Tool Programming 
Environment

Both tools are designed to work 
together for cross-platform multimedia 
development.

The Apple Media Tool

Here are some features of the Apple 
Media Tool:

• Lets you assemble media elements and 
add interactive features without 
writing any code.

• Uses object-based authoring, for 
rapid creation of prototypes using 
rough-draft media elements.

• Preserves interactive connections 
when finished media elements are 
substituted for rough-draft media 
elements.

• Optimizes hard disk-based and CD-

ROM-based projects.

• Lets you author on Macintosh and 
simultaneously deliver projects on 
Macintosh and Microsoft Windows 
systems.

Apple Media Tool 
Programming Environment

Features of the Apple Media Tool 
Programming Environment:

• Combines the power of an object-
oriented programming language with 
the ease of use of a scripting 
language.

• Makes project code portable between 
Macintosh and Intel-standard 
computers running Microsoft 
Windows.

• Gives access to both Macintosh and 
Microsoft Windows toolboxes through 
a C-language interface.

• Includes both a new programming 
language and a new application 
framework. 

The Apple Media Kit

Alternate Route • Darren Conrad

”Is that what they call a ‘computer leak’?”
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By Bill Kling

Apple Disk Copy is a utility program 
that transfers image files onto 3.5-inch 
floppy disks, whether 800K or High 
Density. (A High Density, also called 
FDHD, disk holds 1.44MB.)

Increasing Memory Allocation 
(for High Density images)
If you are reading High Density images, 
follow these steps to increase the 
memory allocation for Apple Disk Copy 
to 1600K:

Apple Disk Copy 4.2: 
Installation and Use
To install and use Apple Disk Copy 4.2, 
follow these steps:

STEP ACTION

1 Select the Apple Disk Copy 4.2 icon.

2 From the File menu, choose Get Info 
(or press 

 

x-I).

3 In the Current Size box, type 1600.

4 Close the Get Info window.

5 Launch Apple Disk Copy 4.2 and 
proceed with Installation and Use 
step 3 below.

STEP ACTION

1 Copy the Disk Copy 4.2 folder to 
your hard drive.

2 Open the Disk Copy 4.2 folder and 
double-click the Disk Copy icon.

3 The title screen appears; click the 
mouse to continue.

4 The main screen appears; click the 
Load Image File... button. (You can 
also select Load Disk Image from 
the File menu or press 

 

x-L.)

Hints and Help

• To launch Apple Disk Copy 4.2 and 
load the image file into memory at the 
same time, double-click the image file 
icon.

• If you want to learn more, read the 
Disk Image Directions document in 
the Apple Disk Copy 4.2 folder. 

5 Choose the image file you want to 
copy to floppy disk.

6 Click the Open button. A message 
appears: “Reading the master disk 
image into memory...” After the 
image is loaded into memory, the 
Make A Copy button is highlighted.

7 Click the Make A Copy button and a 
prompt appears: “Please insert a disk 
to COPY ONTO...”

8 Insert a floppy disk (formatted or 
unformatted) into the main floppy 
drive. This message appears: “Now 
copying and verifying a disk...” 

If there is already data on the disk, a 
beep sounds and a dialog box 
appears. If it's okay to write over the 
disk, click the Duplicate button. 
Otherwise, click the Eject button. If 
you eject the disk, the main screen 
reappears. Click the Make A Copy 
button again and insert a different 
disk.

When the image file has been 
transferred to the floppy disk, the 
disk automatically ejects.

9 For each image file you want to put 
on floppy disk, repeat steps 4-8. 
When you are finished, click the Quit 
button. (You also can select Quit 
from the File menu or press 

 

x-Q.)

STEP ACTION

How to Install and Use Apple Disk Copy
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Tell Us What You Think
Tell us what you think of the Information Alley. We want the Alley to be as useful for you as possible. Your feedback 
will help us reach this goal. Please fill out this form and fax, mail, or email it to the address at the bottom of this page.

Content

Were the articles interesting and informative? YES NO If NO, please explain:
______________________________________________________________________________

How was the technical depth of the articles? NOT ENOUGH ABOUT RIGHT TOO MUCH
Comments: ____________________________________________________________________

Did you find any specific article especially useful? YES NO If YES, list which one:
______________________________________________________________________________

How is the frequency of the magazine? TOO OFTEN ABOUT RIGHT NOT OFTEN ENOUGH
Comments: ____________________________________________________________________

How is the length of the magazine? TOO LONG ABOUT RIGHT NOT LONG ENOUGH
Comments: ____________________________________________________________________

Format and Layout

Is the format and layout easy to read and follow? YES NO If NO, please explain:
______________________________________________________________________________

Do the graphics enhance or clutter the magazine? ENHANCE CLUTTER
Comments: ____________________________________________________________________

Did you read the magazine online or did you print a copy? ON-LINE PRINTED COPY
Comments: ____________________________________________________________________

Please describe ways in which the Information Alley could be improved, or give us your ideas on future articles.

_____________________________________________________________________________________________

Personal Information (optional)

Please let us know who you are in case we have questions about your suggestions or comments. 

Name _________________________________________________ Telephone ___________________________

Company ______________________________________________ Email _______________________________

Address ______________________________________________________________________________________

City _______________________________ State ______ Country ____________ Zip __________________

Type of computer(s) _______________________________________________________________________

Primary software applications: _____________________________________________________________________

Information Alley, 1200 East Anderson Lane, MS: 212-STI, Austin, TX 78752 – email: alley@apple.com; fax: (512) 908-8018
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